Getting started with
R and RStudio




®Studio®

The dashboard

The engine



A tour of RStudio
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Console

O -0yl A Go to file/function

Console  Terminal Jobs

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/

R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ‘'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale
R is a collaborative project with many contributors.
Type 'contributors()' for more information and

'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

|

?\\ 01_welcome-tidyverse ~

= Environment  History Connections Tutorial
<2 |- | 7 Import Dataset ~ { = List ~

7} Global Environment ~ Q

Environment is empty

Files Plots Packages Help Viewer -
% New Folder = @ Delete = | Rename ﬁ More ~ @
\: iching > Workshops > 2020-gpl > 01_welcome-tidyverse @
A Name Size Modifiec
.Rhistory 95 B Jul 8,2
00_phones.Rmd 0B Jul 7,
01_getting-started.Rmd 0B Jul 7,
02_data-basics.Rmd 0B Jul 7,
03_visualize-data.Rmd 0B Jul 7,
04_transform-data.Rmd 0B Jul 7,
cheatsheets
 data
gpl-welcome-tidyverse.Rproj 218 B Jul 8,
README.Rmd 0B Jul 7,
[ 20 slides

=0

Is awaiting your
instructions

Type code here,
ress enter, and R
will run it
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Your turn

se - RStudio

[ J
O -0y~ A Go to file/function - Addins ~ R 01_welcome-tidyverse ~
Console  Terminal Jobs = Environment  History Connections  Tutorial —c yp e 2 I 2 I n e

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ = H 7 Import Dataset ~ 2’ List ~ -

7} Global Environment ~

R version 4.0.0 (2020-04-24) -- "Arbor Day"

Copyright (C) 2020 The R Foundation for Statistical Computing

Platform: x86_64-apple-darwinl7.0 (64-bit) Environment is empty |

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.
Type ‘'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale Files Plots Packages Help Viewer -0 PreSS en l e r

© ) New Folder | © Delete  =|Rename = {3 More ~ ]

R is a collaborative project with many contributors.

Type 'contributors()' for more information and “Jiching  Workshops » 2020-gpl » 01_welcome-tidyverse (&
'citation()' on how to cite R or R packages in publications. 4 Name e Modifieq
t.
Type 'demo()' for some demos, 'help()' for on-line help, or ] ©7 .Rhistory 95 B Jul g, 2
'help.start()' for an HTML browser interface to help. | @] 00_phones.Rmd 0B Jul 7,
Type 'q()" to quit R. | @] 01_getting-started.Rmd 0B Jul 7,
N I | @] 02_data-basics.Rmd 0B Jul 7,
| @] 03_visualize-data.Rmd 0B Jul 7,
| @] 04_transform-data.Rmd 0B Jul 7,
| 7] cheatsheets
) ] data
_ | [R] gpl-welcome-tidyverse.Rproj 218 B Jul 8,
| @) README.Rmd 0B Jul 7,
) slides
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This is ephemeral though.

If you want to run this again, you'll have to type it again.

Store R code in a document instead
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Files pane

o - 04 (= e A Go to file/function |+ Addins ~ R 01_welcome-tidyverse ~
Console  Terminal Jobs = Environment  History Connections Tutorial —c
~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ < H ~# Import Dataset ~ { — List ~ 5 v

7} Global Environment ~ Q
R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit) Environment is empty '

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ‘'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale Files Plots Packages Help Viewer -0

©) New Folder | © Delete | =] Rename Q More ~ e

R is a collaborative project with many contributors. E
[_Jiching > Workshops > 2020-gpl > 01_welcome-tidyverse @

Type 'contributors()' for more information and

‘citation()' on how to cite R or R packages in publications. 4 Name Size Modifiec
t.

Type 'demo()' for some demos, 'help()' for on-line help, or ©] Rhistory 95B Jul g, 2

‘help.start()' for an HTML browser interface to help. @1 00_phones.Rmd 0B Jul 7,

Type "q()" to quit R. @7 01_getting-started.Rmd 0B Jul 7,

N I @) 02_data-basics.Rmd 0B Jul 7,
@) 03_visualize-data.Rmd 0B Jul 7,
@) 04_transform-data.Rmd 0B Jul 7,

(] cheatsheets

) data

R gpl-welcome-tidyverse.Rproj 218 B Jul 8,
@] README.Rmd 0B Jul 7,
(] slides

All the files in your
current working
directory
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Your turn

se - RStudio

© -log|-
Console  Terminal Jobs = Environment  History Connections  Tutorial —c

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ = H 7 Import Dataset ~ 2’ List ~ -

# Co to file/function ~ Addins - $ 01_welcome-tidyverse ~

ind 01_getting-

7} Global Environment ~
R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit)

started.Rmd

Environment is empty |

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ‘'license()' or 'licence()' for distribution details.

[ ] [ ]
Natural language support but running in an English locale Files Plots Packages Help Viewer -0 ‘ 0 n I l S na m e l 0

R is a collaborative project with many contributors. ?— e el |G Bk s | {00 _ J
Type 'contributors()' for more information and Jiching > Workshops > 2020-gp! > 01_welcome-tidyverse (& | ..
'citation()' on how to cite R or R packages in publications. 4 Name e Modifieq
open the file
Type 'demo()' for some demos, 'help()' for on-line help, or ] ©7 .Rhistory 95 B Jul g, 2
'help.start()' for an HTML browser interface to help. | @] 00_phones.Rmd 0B Jul 7,
Type 'q()" to quit R. | @] 01_getting-started.Rmd 0B Jul 7,
N I | @] 02_data-basics.Rmd 0B Jul 7,
| @] 03_visualize-data.Rmd 0B Jul 7,
| @] 04_transform-data.Rmd 0B Jul 7,
| 7] cheatsheets
) ] data
_ | [R] gpl-welcome-tidyverse.Rproj 218 B Jul 8,
| @) README.Rmd 0B Jul 7,
) slides
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Source pane

R is a collaborative project with many contributors.
Type 'contributors()' for more information and

‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

g

Type 'demo()' for some demos, 'help()' for on-line help, or

qp (=i = # Go to file/function Addins
@ 01_getting-started.Rmd = Em
&a & VA & kit - - 3 insert ~ SRun - | & - | = f <
7 === D]
2 title: "Getting Started with R and RStudio"
3  output: html_document
4 ---
5
6~ """ {r setup} »
7 library(tidyverse)
ga
9
10 ~ ## R Markdown n
Hl File
12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension). €4
When you execute code within the file, the results appear beneath the code. [
13
14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by
1:4 [ Getting Started with R and RStudio + R Markdown % (
Console  Terminal Jobs =0 10
O

‘citation()' on how to cite R or R packages in publications. 0

Documents
open here
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R Markdown

O -yl &5 | | A Go to file/function
@ 01_getting-started.Rmd ==l Em\
& el DL *3 insert - ®Run - | B - | =
= B ]
title: "Getting Started with R and RStudio"
output: html_document
6~ " {r setup} »
7 library(tidyverse)
8a 7"
9
10 - ## R Markdown
File
11
12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension). &
When you execute code within the file, the results appear beneath the code. [
13
14

R code goes in **code chunks**, denoted by three backticks. Try executing this

1.4 3 Getting Started with R and RStudio * ] R Markdown I
Console  Terminal Jobs

=0
~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/

R is a collaborative project with many contributors. O
Type ‘'contributors()' for more information and @]
‘citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

O
>

Document format that
combines text and code

Acts like a notebook
for your analysis
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R Markdown

@] 01_getting-started.Rmd =
DA Qe i - @ insert - AR B =
10§ ## R Markdown
11

12§ This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.

i3
14§ R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by

clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

15
16~ " {r} =z
17 ggplot(data = mpg) +

18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)

194

40-

eoe

LX)
oo

30-

hwy

900

1900

o0

o eoe
@

12/33



R Markdown

@] 01_getting-started.Rmd —

- | A @ knit ~ 3 Insert ~ #Run ~ | ‘5 -
10 ~ ## R Markdown

11

12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.

13

14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by

clicking the *Run* button (a small green tr‘iangle)”\rurirtrhirnr the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac). 0 e
15

16 " {r} z
17| ggplot(data = mpg) +

18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)

198 "

il |Ch

40-

eoe

30-

hwy

900

000

o eoe
0o
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R Markdown

==

@ 01_getting-started.Rmd

@] & VA @ Knit - *3 Insert #Run ~ | 4

% -
10 ~ ## R Markdown
11

12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).

When you execute code within the file, the results appear beneath the code.
13

14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by

clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

15

16+ 7 {r} z )

17 ggplot(data = mpg) +
18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)

11 Output

30-

eo
oo

eoe

hwy
oe

900

o eoe
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Your turn

@] 01_getting-started.Rmd

[ ] [ ]
=

BT Read the Instructions
10 ~ ## R Markdown
11
12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).

When you execute code within the file, the results appear beneath the code.
13
14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by u n e CO e C u n y

clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor

inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).
15
168 ~ " {r}

[ J [}
= clicking the play button
17| ggplot(data = mpg) +
18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
100l

40-

30-

hwy
]
X X J
o0
o eoe
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Add a new chunk

Put 2 + 2inthe chunk and run it
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Knitting

"Knit" an R Markdown document into a standalone sharable file

@ 01_getting-started.Rmd —
- & QU G Knit - 0 - Y@ insert v | ¢ SRun ~ | & v | =
@ Knit to HTML 20 oty 25 30 35
=_ Knit to PDF
| Knit to Word
20 jud
21 ~ Knit with Parameters...
22
Knit Directory >
23 icking the *Insert Chunk* button on the
& Clear Knitr Cache... d/Ctrl+Option+I*,
24
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R Markdown

The best way to combine R code and narrative

We'll use it throughout the class:

I'll provide starter code

You'll complete "Your turns"

In the end, you'll have an annotated record for yourself
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Spot the difference:

filter(mtcars, cyl == 4)

four_cyls <- filter(mtcars, cyl == 4)

Find these chunks in the notebook and run them.

What's different about what happens?
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<- assigns the output from the righthand side to a variable with
the name on the lefthand side

four_cyls <- filter(mtcars, cyl == 4)
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yEnvi nnnnnnn r::ttozase::ci nnnnn ions  Tutorial . '=,:||' LiSt Of all the
7 Global Environment « Q variables youlve CreatEd

N
&
3
O
e
111
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Find four_cy1s in the environment pane.
Click on the name four_cy1ls

What happens?
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@ 01_getting-started.Rmd

mpg
22.8

-

24.4
22.8
32.4
30.4
33.9
21.5
27.3

© O N OO U A W N R

26.0

=
(<]

30.4
11 21.4

A % Filter

cyl

4
4
4
4
4
4
4
4
4
4

4

four_cyls
disp hp
108.0 93
146.7 62
140.8 95
78.7 66
75.7 52
71.1 65
120.1 97
79.0 66
120.3 91
95.1 113
121.0 109

Showing 1 to 11 of 11 entries, 11 total columns

drat
3.85
3.69
3.92
4.08
4.93
4.22
3.70
4.08
4.43
3.77
4.11

wt
2.320
3.190
3.150
2.200
1.615
1.835
2.465
1.935
2.140
1.513
2.780

gsec
18.61
20.00
22.90
19.47
18.52
19.90
20.01
18.90
16.70
16.90
18.60

vs

[ R = T R e R e R e N

am

H B R 2 O R B B O O K

Q

gear

A U A WA B D BN~ B D

=0

carb

N NN R B R N B NN P

Clicking on an object in the

environment panel opens it
an interactive viewer tab
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four_cyls <- filter(mtcars, cyl == 4)

Functions do things
Functions take arguments, output results

If you want to keep the output, assign it to a variable
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To look up the help page for an R function,
type this in the console:

?function_name

(Or google it!)
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Help pane

Y Y - v — These help pages prove
Rﬂ::‘u;r;;ol;l,v; with matching conditions ~ Find in Topic T d etai ls a bo ut th e a rgu m e ntS

you can supply a function

Return rows with matching conditions

Description Often full of examples

Use filter () to choose rows/cases where conditions are true. Unlike
base subsetting with [, rows where the condition evaluates to NA are

at the bottom

dropped.

Usage

filter(.data, ..., .preserve = FALSE)

Arguments

.data A tbl. All main verbs are S3 aenerics and onrovide methads
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Look at the help page for seq

Add a chunk that uses seq() to create a

list of numbers from 5 to 100, spaced by 5
(so 5, 10, 15, 20, ...)

02:00
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seq(from = 5, to = 100, by = 5)

##  [1] 5 10 15 20 25 30 35 40 45 50 55 60 65 70
## [20] 100
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Common syntax problem #1

Missing closing parentheses or quotes

mean (mtcars

"Oops this is wrong
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Common syntax problem #2

Surrounding something in quotes when it should be (or vice versa)

mean("mtcars")

## Warning in mean.default("mtcars"): argument is not numeric or
## NA

## [1] NA
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There are three chunks under "Syntax gone wrong"

Run each, read the error message, and try to fix the syntax
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Cheatsheets

Go to Help > Cheatsheets to find quick
reference guides to different packages

RStudio IDE :

Documents and Apps

) Open Shiny, R Markdown,
i) er Sweavs, LaTex, R es
"~ and more in Source Pane

Render Choose Choose Insert
spelling output output  output  code
format  location _chunk

3 umpto Jump™ Run " publish ” showfie
¢ previous tonext  selected tosenver outine
H lines

& Access markdown guideat

1+ Help> Markdown Quick Reference

2 Jumpto Setknitr Runthisand Runthis
2 chunk  chunk  allprevious codechunk.
Z options _code chunks

174 orbssare, e 3
it plortoresare)

. CHEAT SHEET

v QR aAv g4

Write Code R Support

Navigate Openinnew Save Findand Compileas Run Importdata  History of past  Display Pre:
o ile > New File>

Pro Features

ShareProject  Active shared
with Collaborators.. collaborators.

tbs  window place notebook  selected  withwizard  commandsto
code

RStudio recognizes that fles named app.R,
and global.R b

oo shiny s

H Run”"Choose ““Bublishto - Manage
d 2pp location to shinyapps.io publis

Changefile type.
ang

Crete | Upload pelete ename | mamtemn
folder {fle  fle file o

Path to isplayed directory
Working Maximize, +

Qo o S0
s 5 e e s
S mvmang< o) amR e 0] g g -0
1 |# Good Start

2% Cunorsof | Ferun Sourcewithor Showfle | load  iSwe  Deleteal  Seachinside

3 “sharedusers previouscode  withoutEcho. outine | workspace [workspace  saved objecs  envronment

s Multiple cursors/column selection Choose environment to display from Display objects
& wposseosis i Att s mouse drag 50t parentemronments astiore
R : Code di tics that the o

& “Mestooer  Codediagnostics thatappear i the margin .

3 “Reatooss- __Hoveroverdagnosic symbols fordetats, | QUL 150 o of $ vrteles J
F ; s

Syntaxighiighting based .

i h .
012" get_digit <-functionO) { onyou ﬂi&exrer\so foo function (O
AL3  Cesc % (19 4 0) ‘Tab completion to finish
L xraen - funchonpames, Nepaths, | Displayssavedobjectsby  Viewindata  View function
015 1} arguments, and more. e with short description viewer source code
4 guments, type t descript

7 Multi-language code s Pots Packages Melp Viewss -
gy Gt SNIpPEtSto quickly USe | Quewrasr Gt O oo g tme @rte-

;. -ommon blocks of code. e Ckcsinen o ®

ge

e dieciory

B e+ s in current project

5 ot 1122- CloseR
T Sessionin
project
Select
RVersion
PROJECT SYSTEM
il Proiect

RStudio saves the call history,
workspace, and working
directory associated vith a
project. It reloads each when
youre-open a project.

meof
current project

RStudio opens plots in a dedicated Plots pane

Navigate “Openin Export " Delets  Delete
plot__allplots

nt plots_window _plo lot

GUIPackage manager lsts every nstalled packzge
[riaptiengi~t m
Install  Update  Create reproducible package
Packages Packages lirary for your project

e Press4 tosee  Drag par 4 AFile browser keyed to your working directory. e— ==
ot aory DaBEENe.”| Eekon oo oo mame mnen oot e tefe
librar version from
. ottt deachl iy
Debug Mode Version Controlwmciorsw ===
Launch debugger  Open traceback to examine 4 Tumonat i i it Udlo opens documentation Ina declcatec fleppane
i3 bug(), browser(), or 2 breakpont @5 swee Showfie Commit  Push/Pull view .3
b oferor G e S s tormmate tiew EERES
s e =5 Homepageof  Searchwithin  Searchfor
Click next to’ o ‘Added o comin v P i fil
Clcknestto™. > foo®) o S = helpful in heip ile help file
add/removea | Error in get_digit(num, XD.; + Show Traceback W Modified | ool ™ Viewer Pane displays HTML content, such as Shiny apps,
breakpoint. Error! erun witn Do med | Open shellto sha. current RMarkdown reports, and interactive visualizations
Sy S
Highighies Console —/1DEchestsheet =0 L.
ez sswa ™ o pcowne msw | Package Writing
SSiontas
paused File> New Project> e
New Dire > RPackage or— .-\c-u U Sepuwith  Peealiength  Puialwieth  Spec
Stepthrough Stepintoand  Resume Quitdebug Tum project into package, — o
environmentwhere  in executing intracebackto codeoneline outoffunctions _execution mode Enable roxygen documentation with a " L f e
execution has paused  environment debug atatime 0 run Tools > Project Options > Build Tools 2
Romgonpidect == S Pteowsbyale  Sonby  Sesch
o e ! aralserange e ioraie

GStudio

- RStudio DE 099,832 «

Inc. - CCBYSA Rstudio .
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Data basics



